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12,

13.

14.

15.1

16.

17.

N CERS]

- (py M (© frodt (d) yas
(a)
feﬁ?mmﬁl ,
o T3 (b) TSI () =M ()~ HEg
539 & v 3 e fdat fami 2 3o

35 fird wg3 maet € f e mew ¥ SE A -

frge dat nrege Tt d=|

(@) Toud () THEEER () HewE (d) Bsrawdt
&' fdot famy 2 g g

(@) T3 b) f5s NCa (d &

10 persons at a party shake hands once with everyone else in the room. How

handshakes took place ?

fes et 29 10 fenrerst o013 s s foh s il o e a1 RS - (handie
o 7

(@) 66
(cy 45

(b) 64
(d) Nome of the above/€ug fafzni f&F 3t &

Which of the following body is I€Sponsible for promoting hockey in India at present ?
vigeT AR 89 3703 5 oot & €39S s et s fidindt 4 vl v fidlerg 3
(@) Hockey India/ameli fEm

\az/( Indian Hockey Federation/ 393} oieft 85350

(c) Federation of Hockey in India/ CEL )T na Tt e R
(d) Indian Hockey Promotion Federation/ /a3t ameit Yins 2530

. 4 ' o
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o s the name of the technology on which ¢p

@ﬂﬁﬁagaﬁméfﬂnﬁﬁr@aﬁvﬁ KISUCERE

" plockchain technology / SESE IaEHH
obotic process automati

,(1"( Robotic p omation/d8fee Yfafanm SV

Machine learning / pir s

mternet of Things/ fEea&e wiz fgamy

Yptocurrency is based ?

g
(@
ruent population of a town is 50000. It is growing at the rate of 5% in first year 4% in
ocond year and 2% in third year. The population at the end of third year is

s el & Mg mmeret 50000 31 feg ufad s 59 o s 4% w3 3 S 2% & 29 &% 24 gdl

pome—T"

| 3 s @ i3 fEg nrETEh 3 —

2 55500 (b) 55692 © 54600 /(.{/54692

~APSTONE a satellite which was in news recently is launched by ?

- APSTONE fa #omvete  fa avss ot ¥ et fw o, s gorar &9 i famrmd 2

a2 15RO/ fed (b) NASA/EH —
() Roscosmos/IHAFHH (d) CNES/CNES (o0 S
7/
Which paxt of the body is most affected by Mercury ?
ko o i ot 3 e § F yEes g d ? ges 50/@5&
(a)v Brain /fexrar . -S/Ua 7 %.,?)
/Qb{ Lungs/3ed )
(© Nervous System/ forraft yereit | 6 o 7-/5'f\
(d) Liver/frar@ 9 —
. Lo | @°
Which country won the FIFA World Cup 2018 held in Russia ? %
7 o s e ey 2018 for 28 B ST i
(2) Wroatia/ e V(BY Brazﬂ/quﬁ.B , ~
() Germany/waHat % fisince/ TR A ( o°® (

UIDAI has launched a new mobile app mamed ______ which performs  face

authentication ? ; Yarels My _
UIDAI%&)’H@E&W%H&%W Waﬁ?ﬁﬁrﬂ@ﬁm 3

@ FaceR Face Identifier § 60
: ace Recognition ’ . o> °
() Aadhaar Face Recognition S,LD \ =0

(©)  Aadhaar FaceRd

/C _ -T.O. ’\/‘79
J
A Em— _M%;eqchingninjq.in
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e of IW A World Water Congress and By
¥

24. Whatisthe the \EHH?S"‘ 2022 & e
gIB3 €cd o

(a) Water for gmart jiveable cities/ Ifa ggr P et =
a a

(b) Water for planet/ 3fio Bl uui
(C) Water for cities/ wfga’ S

& Water for all /73 BE et

hibition 2022 2

25. I{Y =50 and WATER = 134, then DAD will be equal to

ST Y =50 M3 WATER =134, TDAD—%__@W@HFI
]

v d‘( 18 ®) 9 R @
N

26.  Which of the following is not a literary compaosition by Kalidasa ?

I fefing & frasht artem & wiosa a9e st 3 2
(@) Meghaduta / QU@S
(b)  The Raghuvan [ TUES

Abhijnémashakuntaia/ ”fFéBTq'?SH‘éfw
(d)  Panchvati/{fgeet

27. Orienfal Bank of Commerce K

as been merged with which bank ?
Sdnics S5 nia IHIH w fgH

9 5 Sk i fam 32
(@)  Bank of Baroda /&g wre SERy

{b) State Bank of India/mez 85 iz RSy
(© Indian Bank/ féstwes dg

,\9/ Punjab National Bank /g o

6 \\\_

28.  Who among the tollowing led the Bardalj Satyagraha in Gujarat ?
51 WS RS et Aty o gt i ot -
W Sardar Vallabhbhai Patel/ Haurg <5 o ydg
{b) Mahatma Gandhi / HT3HT gyt |
(c) Jawahar Lal Nehru/ wewg g ofaog
(d) Gopal Krishan Gokhale, 3 fimes shaa
FG/C o
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I L has 1000 kg of sugar part of which he sells at the profit of 9% and the reg; o the

- .Um - s at 19% profit. His overall gain is 15%. The quantity sold at 9% profit g
| » _..11‘ ]1

@qmmoofaﬁusaf‘ﬂm&@feam@m% ¥ yee 32w I i3 gl Y3 Qg 199, o 3

r;J,gﬂgre_mWBwf’/ 3 9% w3 eFt et yzar g 3 2

o0k (b) 400 kg (© 560kg (d) 640kg
¢

st Lithium cell manufacturing plant of India shall be developed at :
553 & ufaes fsefnii A feare usie fag feams dizrgoar :

() Tirapati, Andhra Pradesh/ f3gusl, nitagr yam

() Chennai, Tamilnadu/ Jadt, a3

(¢) Vapi, Gujarat/ i, 8_1?{8‘3

(dy” Boisar, Maharashtra/8feng, Hagmeag

p

Quit India Movement was launched in response to :
fare 7o €9 5793 €3 »iews wg offst famr #t ;
\gz()/ Cabinet Mission Plan/ gfse fige et
(b)  Cripps Proposals/ faqum yrze
()  Simon Commission Report/ AEHS afims € falge
(d)  Wavell Plan/ 25 te v

Who started the Manji system in Sikhism ?
a3 iy gay €9 ¥ieft e <t ggors 15t ?
(@) Guru Nanak Dev/3Ig a6dl €€ it
b)  Gury Angad Dev /dIg widTe e A
2 Gury Amar Das/ dig "HaTH il
4 Gury Gobind Singh / g difde it 7

Choose the word within the group that i the least sim
IR g G e g § e ow e FUERTEIY
A1 Duck (b) Swan ) Goose

ar to the others.

(d) Parrot

ﬁ 7 7.T.0.
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34, Whereis cent? o 37
e iy e | e |
(a) Kapurthala/ YT (b)  Ferozepur,fedwmyg
‘ ) (dY" Amritsar/n}
(c) Jatandhar/ GIZRE ( /i
lycemia and hype;glycaemia are related to which among the followin
olyCemnlld « o m
35, Hypogly i3 RGEE M flrrest R fom s v9ifrs s
e gTEHn i
(@)  Blood Sugar/ 793 HdI9 (b)  Body Fat /e gad
(c) Respira-tion/ HJ (d) Thyrm d /E@%ﬁas
36. Computer keyboard shortcut which is used to change case is
duGes Migs moede Han TeBe S i Wl
(@) Ctrl+F3 By Shift + F3
() Alt+FE3 A Ciol 4 i +
37.

38.

39.

(d) Sardar Maha Singh /Aaeg Ha fifus

When was Punjabi Suba originated ?
Urret mr e e fitg nifing |
(@) 1 November 1965 /1 553 1965

& 1 November 19¢¢ /1583 1966

{©) 1 November 1968 /1 &E87 1968

(d 1 November 1967 /15283 1967

Which is the state bird of Punjab ?

A = I et G

{2) Pigeon/ 839 ‘Oa)/ Falcon/gwq
()  Peacack/Ng (d) Sparrow/fo

What was the name of the father of Dalip Singh,
Uarg 2w ity oo mety By @ g @

(a)  Charat Singh/933 ity
\037/ Maharaja Ranjit Singh/Haaw gemis figuy

the last Sikh King of Punj

al
ot s HY

()  Buddha Singh/gu Py

FG/C

8

;@ Teachingninja.in



0. Whichof the folloyy; ‘

o eion 7
p sion ¢
. ve divl
A part of the pynjab administrat

(a) Faridkot Division/a’fﬁ'@ég . e )
[EEIE
\(bY~ Fazilka Division/afﬁraaﬂ‘séﬂa
() Ferozepur Division/ fedmyg s
(d) Ropar Division/gys [ESIE

g1,  Which of the following is the correct order of the four major functions of a computer ?
AIGET 2 T8 o Setmes o ekt g forgr 2
(@)  Process, Output, Input, Storage/yfafemr, i, feaye, o
(b) Imput, Output, Process, Storage/ fosyz, mEele, \{farf’a"'rf', HEIA
(¢)  Process, Storage, Input, Output/yfsfan, qe3m, fewye, Eed<
@/ Input, Process, Output, Storage/fesyz, yffenr, »rgede, A

42, When was the foundation of the British Empire laid in Punjab ?
g &g fgfen maw <t o < it arhl
@) 1849 (b) 1857 (© 1882 (d) 1850

43. At which place in Punjab 'Roshnian Da Thiuhar’ is celebrated ?
Srreiet @ e e 2 o ey 3 B 1
(a) Ludhiana/gfPe |
\}}’9/ Jagraon/HAEE
(¢) Jarag/Tigdl
(d) Malerkotla/ HEIACS

recogniZIng a PIre-specifia

wing is Capable of d type of mark by pencil or

44. Which of the follo
Iz fafimyt f&6 8T8 -(b)

(c) Bar code 1€

] i PTAN
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et ell yange A3 through G3 shoujqg be keyed in as
dsher™ 5 R
ﬁaﬁgaﬂf\ﬁ@ﬁfﬁ'ﬁ?ﬁﬁm_ A5 Hrer e 3

rea
45.  Inacomputer 5P

fir fufges TN \(9/ 15:G3 ©) ARG3 (d) A3toq
(@) A%G

pe the fist POCL of Punjabi tanguage 7
46.  Who is considered 10 WWW@ 5
()  Baba Butteh Shol¥/ o
(b)  Guru Angad Dev Ji @ O Eil
(€)  Waris Shah/e6" 79
Wt Baba Farid Ji/ e e
47. What was the old name of Bathinda ?
afE3 T yare st
A Bikramgarh/ feqarg

(© Phul /&5

(b). Ramgarh/'cl""-lar;,}r
{d) Bahia Fort/srdo fie

48. Which is the main source of irrigation in Punjab state ?

W mmﬁaﬂi@eﬁwﬁammﬁs
T (@) River/zH

(b) Canal/sfyg
(c) Rain/Hig

(d) Tubewell/ feBuds

49.  VLOOKUP function ___

—
VLOOKUP &M |

\@/ Finds related records / Ay gz g9y
(b)  Looks up text that Contajy

(<) Check if two cells aye identie

{d) None of above/ Budss oy

Uiy aee A e R s
e

FG/C
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The A nglo-Sikh Wal‘wwréréigo’ﬁglilt Betvxééen :
Mg-fﬁﬁﬁqmﬂ*éfﬁ?f@amgﬁthM|

\(/ﬁ >/Between the British and the Sikhs /MR 3 fityt fegag
(t) Between the British and the Muslims /Mo 3 yAgHS' feged

(¢ Between Sikhs and Muslims /fifdt 3 yrsest £
(@) Between Sikhs and Rajput kings/ st 3 gz grfimrt fegara

51, Which of the following movements is not a part of Gurdwara reform movement ?
3 fdnit wfagt {9 faodt Bfag IRens mug siyg o fim adt 31
M Saka Nankana Sahib/&&are Hfas @ mrar
(b) Jaiton Da Morcha/ A3 o g
() Naamdhari Movement/ SHUT Bigg
(d) Guru KaBagh Da Morcha/dg & &ar <! PREN

52.  Which of the following is a correct format of Email address ?

a@ﬁéﬁémﬂﬂﬂu%@nﬁaaﬂzé? _

. . %l‘
(@) name@website@info'?z (b) name@website.info |

/ L d) name.website.com “ﬁ
ﬁL‘Z)/ www.nameofebsite.com (d)

damage oF cause threat t0 a system or network is broadly termed as
53.  An attempt to harm, dam :

| ' 2 %2 39 3
2 (Fo8E, T TS T vzw Yo aun & A B
fot fren i He=ad & TO C
frgrAer 1
'\/C_@)/ Cyber-crime/ FrefEa ™
(b) Cyber Attack/ ﬂ@wm )
acking/w

(c) System hij

nud™
Digital crime/fS1E®
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ut
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T
e
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5 ‘f-/Wlm was the pioneer of yardhan period ?

Tours o w e ST A
/45)/ Harsh Vardhan/ RLECSRTS (b) Pushyabhﬁti/ Eﬁ:f’*l'@?ﬁ
(¢} Pushyamitra/ yfkerfisd (d) Kanishka /afSng

55.

e e arse 3 st

@) Abohar/migg

(b)  Shri Muktsar Sahib/H} Ha=Ad Arfiry
NCg Ferozepur/fasmg

) Bathinda/sfis

56. V:fho 18 called Manchester of Punjab ?
m?%%mwﬁl
@) Chandiggrhzﬁaﬁaq |
(b) Bathinda /gfag:
NCd Ludhiana /gftprrs
(@ Gurdaspur/ argemmyg

57.

. ﬁm@ﬂwﬁw@é#wém%ﬁmét

8y~ Sitala Mata/mizgr s
(b) Vaishno Mata/2%& vyt
() Kali Mata/3mt sy

{(d) Mother Lakshnii/Samft s

FG/C IR

Before declaration as District FaZilkaWaS-part of

e fJA Ah

"Ihe festival of Jarag is held in honoy of which o
Zoddess ?

ﬁ\\\
12
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61.

curdt Gahib compiled Sri Guru Granth Sahib ?

(hich

5. Fﬁaﬁafaﬂfraa = Hiwse fan grg igers & 13T

Guru Harkrishna Ji/3d Jafgrs it
(@
b Guru Ram Das Ji /3G IHEH it

o Guru Angad Dev Ji/ard nigre B
‘d)’f Guru Arjan Dev Ji/JIg MIHG =
/; »

pani of how many Gurus is included in Guru Granth Sahib ?

@@amﬁaﬁ%@gmwm@mm
\(};/ 06 by 09 © 10 d 13
gmall text files that websites put on your computer to store information about you and your

preferences is known as .

T _ = Frent Aem 3| :

() URL/Gnd WS \gp)/ Cookies/TellH
@ Address/n=dH (d) Home Page/dH Un

Which of the following method can insert a NeW slide in current presentation ?
WWW@%‘W?@?W%@%E@?WW%W%?
{a)  From Design menu choose Pagesetup/ famela s 3 ¥l S 3= =3
\(b}~ From Insert menu cho0s€ New Slide/fEoRSE Hig 3 ol mwets g2
se Layout/ff*f%gg’@e‘kéaaé
ot/ fig S A STy

() From Home menu choo

(d  From Home menu choose €

62. Zafarnama is written by __—
HRaenT fim qrg Hfges € 893 3!
(@)  Guru Nanak Dev Ji/3¢ aod 2l
(b)  Guru Hargobind Ji/d¢ gaife G
(©  Guru Har Rai Ji/31d 99 g2
| [d"Guru Gobind Singh Ji/ ajgéﬁg put
FG/ ¢ : = P.T.0.
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(tor spreadshieet SUM, AVERAGE, MIN
puier

and MAX are examples of _|
63. Inacom

229, SUM, AVERAGE, MIN 13 Max g
R g e iy
(@) Calculations/ 3 \(yr Formulas/a*a)dﬁ
() TFunctions/ S0 (d) Relative addressing/98fez Wy

64.  Whose work or creation is Gurt Shabad Ratnakara Mahan Kosh ?
3T TR gsaad Has O fan € a3 7 gwer
/(ﬂ} Bhai Veer Singh/ e dg
(b)  Bhai Kahan Singh Nabha/ I a5 iy
()  Dhani Ram Chatrik/Ta! 3 Irfga

(d)  Giani Gurdit Singh/fart arafiss ity

65.  When was the Khalsa Panth founded ?
WS U & ravus 33 offst ardy
i (@) 1697 (b) 1698 \(9/1699 (d) 1666

66. If each side of a Square is increased by 30%

ﬁaafa”améaéawﬁ{sso%

find the percentage change in the are
Tfenr 7T 3 3t 433 fEe yIhes sadE) o us BArS

@ 56.25 A 65
(© 69 (d)  None of the above /U T i

67.  Which country has the maximum forest cover in the world ?
ot Ro ng 3 Su v fom dw f¥g o 2

4
®F
(a) Canada/3&3 \

(b) Democratic Republic of Congo/ 3ngfed favmfse wiz q
{c) Brazil/ gHie

i : \_9),/I<’.ussia/.§"’:r

-

SRR
FG/C
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e of British Parliament s called

wr 0
Fe

‘ ;ﬁkémmg/,mwél

(1 -
’ HOUSe of LordS/aT@H e géa
&

,/ House of Commons /TG M€ THEH

)
) ; House of Representatives/WSifad Ags
(' !

jterchange the signs and find the correct solution :

3-3 K -2z

=
@ and ¥ (b) + and = (0 +and/ (d) - and *
70.  Which country has won cricket world cup for the maximum number of imes ?
o 30 S W9 3 €0 9 Ty feme Sy fiffsnr 3 2
M\ustralia Vicperasivty (b) India/393
() WestIndies/ewe fédla (d) England/fSars3
3
7l Fundamental duties are given in which part of the Indian Constitution ?
I3 s € fagd (97 e ghont aese RS o s -
(&) Partli(A) (b) PartIV(a) (€ Par
V) \ (dy—PartTII(B)
/. e
72. A Cisfern 1 . 3 . :
b 18 normally filled with water in 8 hours but takeg 2 h
o ours lo i
leak in its bottorm, |f cistern is full, the leak will empty thye ciskern i nger to fill because of a
39 3 8 ufens g Ut aB I8 T I g oy oy ;
ot e maﬁ@ﬁﬁféﬂz’ﬂaa@mm@e
B U1 e & sfanr dfenn 3, 3 §Fa%qﬁﬁggmaa%%w
@) 10 hours /10 ui2 (Y 6hours/g 3 ‘
' 0hours/4p w2 O Toreofthe oy gt g e 2t o
73‘

|
T arow full of sittin g people when counted, Sures}, i 16% frop, both fa i
\ the ends.

mmﬁﬁﬁamﬁaﬁéwﬁgim@ i g
95 5% By et %31@%33.@;;#33‘8@

(4) 80
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By
|
L
e
i
'

ks is equal o selling price of 10 notebooks, fit i
ice of 18 noteboo S, the profit in pey,
74, If cost price O

e (8
;;T;I;gsémmm 3 'ﬁ%ﬁm%wa,ymm%mﬁg ;:
faad: . :
() 50% W/W’ . 1
© 100% (d)  None of the abox/e/@m%fsh{*fé‘é‘aﬁﬁm :

75. You are given that a train ‘P’ is mOVing at' the s

is moving at the speed of 60 ki per hour in th

S meters and it crosses the slower train in two m
)

> 3% S e 4 fa o dead)
[ \0 =

peed of 90 km per hour and another train 4§ |
€ same direction. If length of faster
inutes. The length of slower train i ¢

ainissq
20 Tafies i wer <t wara o il 2 it 4y il

0o @Bﬁﬁ'fﬂ@'@ﬁfewféawm*ﬂﬁlﬁwﬁmamhﬁ@aﬁ@imgﬂ Ei
St Msooxﬁzaam%feaéﬁfz*fésfrﬁm S B § | Tt dzsaiat & et £
c ) 500 metres/500 iz R
C? /lf, A More than 500 meters/500 Hieg 3 &g fﬁ%
gf 1< ’\VLes; than 500 meters/ 500 Weg Y uire 2N B
(d)  Cannot be determined /fsgufys &R 3 77 e Zf’ ' 5 07 @
| = |
Rame'sh said to a man “He ig the son of a man who is the father of the wife of my father’f
How is the man related to Ramesh ? '
TNE ST Rt st i L N NN
| @ (a) Father/fizr (b)  Son/ys - W
() Uncle/nfars Ay Grandfather /@rgr ﬁ;/j—(@;
77. il;;sg ;l;éo;e;t;o;;; s;;i?%? be p;;p)erly adapted to the Question
n 8 8.4 255 9=1 ' 5
’(S/ (@& x, -, +, + (b) X, 5, 4
78.  Which city is called the culture hub of Punjab ? 6/6-) lf
ﬁm@ag;uwaerﬁ%»wa’eafaw@a? ;ﬁ
(2) Anandpur Sahib/ MY Mg X 'y
Amritsar/ wifzrg ' 5
@ Mukisa/ TR R -2
(d) Jalandhar/ ey | 64 |+
FG/C
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Which of the follo

" wing cannot be the square of a natural number ?
feas 128 T o Feash it o eaar ot § sy y
() 30565 ¥~ 745907 (c) 83786 @ 2 A
gp. Whendid Mahatma Gandhi start the Salt Satyagraha ?
HarzHT Tt & g HfEmalfo ad wg st 2
(@) 1929 M) 1930 (© 1951 @

., do the same work in 16 days. In

order to complete the work faster, three persons Ram, Shyam and Sita together finished the
is the share of Sita on pro

work in6 days and were paid total amount Of Rs. 6400. How lTluCh i

g1, Ram alone can do a piece of work in 12 days. Shyam car

rata basis 7
o ke 12 fews' b er v e 31 fimm firlt 1 16 et fE9 o0 e 1 &1 & 3 &8 YoT
I3 B, %Wwﬁwﬁﬁw%ﬁmawmﬁWﬁstﬁwwﬁmﬂw@é
norfaht S5t et Az & migu3 @ g '3 fde fdrr d 2
(a) Rs.1200 (b) Rs.1000 \(,—44 800 (d) Rs. 600 < °°
. o -
82.  Which of the foilowing is exactly divisible by 7,11, 13 and also 16 ? %
5 3 R o 7, 11,13 i3 16570 & el g Sl e 2
@ 16016 (b) 15035 (©) 16026 %19 :
R\ &
83.  Who is the Vice Chairperson of Niti Aayog ? g A
S nidiar e @y SmugRs 8€d S K
() Suman Bery /BHE 3t (b) Ashish Chauhan/‘fHTEﬂH 9IS 9/ 72‘5 |
A Shaktikanta Das/AediEE @ (@ AN Panagariya fusfee e 6y oo
di 4 2 |
8. Tomb of Sand, the first novel written in an Indian languag, Which has won the boo:( LoD
is authored by 4 Ljr p;ze
ufgs e
amﬁgﬁamwﬁaww Nﬁ““ﬁ%mmﬁ{wam P
- 3)
G
(@) Chetan Bhagat /935 3313 \@Y~ Geetanjy; Shree /3t ”
. d) Jhuy '
©  Amrita Pritam/ w3 1113” ( b Lahlrl/ Ry Bhch
] P.T.O.
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fast ridler wants to move at an amazj
‘g speed wit]
1 a

ider on 8th
artake W the ! 18t position with some time and efforts oyey

ther more efforts and co
(ter fur @ rrect dec1sxons at th
€ Correc

HL(
85. Ina C‘PLCdV by ke ¥e
the race OV¢

psition:

winning
rider on 5t p

ve 314 po
Kes the ron position coming very close to winning the racg
N

ride
sider on the race track?

5 the
he e v
he ettt ;. 37 159 I fifze 9 81w 2 &% e mreers ot o ik

0 3 et O fE9
58221}{%68%’?5‘6 3 § V5T 6 8 w3 7 52 s '3 e e
A 3 7idl SHfEnf 3 e, @ahsf‘zaéﬂfas’*éaas'?sgw@

finally overt
at Posmoﬂ 0

afit #3 :
iﬁf e O 3T g e 19
;L% {}’5 @) 15t (b) an (c) 3rd (d) o

What least number must pe subtracted from 23891, so that the remainder is divisible

oggglﬁuémwmﬁré?ﬁﬁ?ﬁﬁ Tﬁ‘&‘&ﬂ876’8€f‘3’ﬂ*)5ﬁ
66

(a) 56 () 46 (C
77 $ si%
/,87// A boat sails 20 km of a rives towards upstream in 4 hours. How long it will take to d
g same distance downstream, if the speed of current is one-fifth the speed of the boz

5 water ?
0 feafémaﬁwrfenﬁfeqfea&??ﬁHZOﬁ&ﬂza@iGané}%l Aed ol <t g5t "itg
ot & 9 = G R 331 67 261 & 95T €8 & YT a6 &9 fdar mi Satar ?

P —

Mours Javie (b) 2 hours 40 minutes/2 Wi 40 fife

(¢) 3 hours 20 minutes/3 wWe20Me  (d) 5hours/5ue : U
26 ’
725, &

88. | Base oéa right-angle triangle is 18 cm and its area is 162 sq cm. find its height :
feaAf-de f3ae & nud 18 Wehfies § w3 fower 939es 162 Taar Héhilea di fert 89

6577

%( By Oom AT 27 cm

G2 (9 36em 5 (d) None of the above/@udas f&J 3¢t &t
57 Az

i
gl 89. A rectangular block 9 em by 12 em by 15 cm is cut up into an exact number of equd

” What will be the least possible y,
ﬁ 5 . umber of cubes ?
e C““@]Zcmmgrbcmaaraaweéna‘}nmwﬁfamwh

8//‘7)7 w3 3 uie Hartes Afmr fda) S,

@ <0 (b) 40

&7 oy (© 50 (d) None of the above/8Ud fefznt ﬁgi_’éé‘iﬁ

%
3% FG/C Y?; | »S E"’m
( . N

U\
A 13
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s

! \
whe  la bagh ?

oY

Jal

",
/ Ceneral Dyer /&3

warren Hastings/ 29 dnfégy
Lord Minto/ Ba3 fife

)

NG
(0
) ‘
) william Butterworth Bayley /feeng HIITTY S}

yas the person who commanded the British force to fire on the crowd present in

e w91 (9 e St 3 fyfers 2am & dief) 9wz wr e 2z e w7

A

17 No 0
%
i

A\

)
5

A sum of Rs. 4240 is to .be divided among A, B and C in such a way that the ratio between
" sand B is7: 6 and ratio between Band Cis 9 . 7 and ratio between A and C is 3 : 2. The

pagR AT E A, B3 C RS fom 39 @fmir e 3 A»@@W7@’”§E”‘3C?

w3 9 (733 AN CEWEUED 281 A w fifr 31

(@ 1442 (b) 2100

/(9)/ 1680 (d) None of the above/§tg féfzmt &g et &t wdt

92, NIFTY50: India : : Dow Jones : ﬁ ﬁ C/,
faedts0 ;593 1 QAR G .
A4 United Kingdom/ Gareifes fdaram 7

P s

()
©

United States of America/Rua3 I MMl
Canada/3&3"

c =7

1
2 =

(@ Germany/ GER|

93.  Dog:Paw::Horse:

: o g HIO
() Harivansh Rai Bachchan/ M?é
() Jaishankar Prasad/#Hed YA™e

() Fast (b) Paw ey~ Hoof (d). Tall |
|
94. Which gas is emitted naturally by the soil ? I
e engr gegst 3g 3 oot am foseet 3 2 |
(@) Radon/335 (b) Propane/Jdw !
() Methane/3i8% ) Argon/nJare
9. ‘Namak Ka Daroga’ a famous social story i writft::ﬁby
| Namak Ka Darogy e e A BREMT IS
V@™ Munshi Premchand/ WesHt PHIT
(b)  Mahadevi Verma/ Hameet &
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. 1qtel't’d to President of India by
[k

e 15 At L
96. The oath of offict! o gt et 91

=

g 2 amedsd o o
ice of lndia/ S
\j‘a?/ Chief Justice © | hdia/g@g \
(b)  Solicitor General of I e

(¢) Vice President/ gua’
Lok Sabha/

79" € mfterg
(d) Speaker of

of Vikram was 13 times the age of Avi. After 10 years ratio of ages of
97. igliiilj\ii(l)’biglcl 23, What i the present age of Vikram ? -
0 s s é%n@eﬁﬁwaﬁl3mnﬁllowmmﬁﬁfe@ag

o s 11+ 23 S e AT P A 3 2
N A @ 36 (b) 30 () 49 U 23

!

| 98.  Find the next number in the sequence of numbers given below :
> nberit -
93 ! Z}ﬂ; ﬁaig)fesﬁw" i Fifmiret 1 dopi fie worl At § 553 -
) , - ¥ A 19
LA = 2, 4,12, 48,240,7
‘ /«ﬁﬁ?ﬁ% L (b) 1024 © o (d) 480
al® < " )

('\r

e
b b 99.  If a solid metal ball with a diameter of 12 cm is melted to convert to a solid cylinder w
l @ same diameter, the height of the cylinder is :
b
%6

Aag 12 Hhfies 2 fenm et 57 7 ) dfe § O v = 7 v oo aeme me g
L. A, 3 e o Gand ot 2.

i ui_|

e @ e ® 6 © 9om @ 8om
Y

i 100. Average age of A and Bis 40 years and similarly, average age of B and C is 42 years an|
P average age of A and Cis 44 yeqrs, The age of Cis :

7. -
2o A m%liiﬁ_zfﬁé'@iﬁé%ﬁfﬂm%&ﬁﬁigmgcéﬂm@wumém%AhBCEW‘m
T 24452752‘11 C S 81a faa '

(a) 44years/44 7T (b) 45 yeérs/45ﬂ18 %\:‘/
2 %Vl (c) 46years/I6HT \/()d»)/ﬁ years/43 A5 A

N
(R

¢ 101, Which countiy Is the winner of Asia 0y 9022 Cricket Tournament ? >
54X . up 2
@reftrrr Sy 2022 fgee gaonte ar g g
_ SRR g ? i
(a) Pakistan/ yianse b India/3 Ct \
\(})f Gt Lanl{ Tl (d) Bangladesh/ HarSeH o |
’__’1—__——"_—_“\\\\______’-——,—————“ '_'—'——_/
FG/C

20
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4ol GO TCPAIE a voad i 14 days working § hours o day. In how many days will 20
G working 7 hours 5 day can complete the oy 2
) ot 2 TR 5 0 Sy 5y TS R R g o) s w0 e 1 fes R 7 uid & =
oD mfb»la"ﬂ“a‘s%wf%adwwaanatmp M \(\t )
s v

!‘ J() d.l_\"b/2( ﬁ—')— \( \l,' \ \(\ ( (_

(¢ \¢ vt . U

0 19 Li.l)'s/'l() fbﬁ ‘ \\'\\ > " y’f L\ l \

e 4 : k% e ¢

o wdays/18 fis /s }; q Q('ﬁ e

N ’ & N “

. : ) ’
iy Cannot be determined /ysr X /C\ + , . &
J canne dete / Bﬁmvwmw \ \l)() RIS
\© 4
. B ¥ Al /l(;‘/ \}\}U
un l}\ SL‘“H\?‘ an i]l'thlC I(,)l' I\S. 3956 Qa tl'ader lncllls lOSS 0( n\“ \\,hdl \\'l” th\ %L‘“ll\l, Pl ch ” hL\ /
s aprofit of 6% 2 oF
R nrgetas 305 63”‘3%?@33@8&3?@6 8% = o Jor d e G 0% o yeer e /V\bf}
. %bssa It Ce "
__\ &\

(.1) Rs. 4556" \(‘,\ Mo (L) Rs.4193

e
() Rs.3718 (}k/ @\ (d)  Noneof the above/Ga fefmi iy 3 < odt %(

1. Who isthe new Chief Jllbtht of Indla ?

e 23 g WP e g ‘ /a‘v j“/
(@) Uday Umesh Lalit/8% €y wfs3 }/ \ T l//ué\" c '276/7
©) NV Ramana/ % & gresr / - /Q— L'?( : ;
\d Dhananjaya Y Chandrachud /w&wer et EECEES o /
(@) Shared Aving Bobde/waE ngfée §a3 Ll 1 \?\G
~ = 79 % |
105, Kuno National Py which has recently been in news is iy —_ _stateof Indi;;. /t/ (2
800575 3 e o i e R o, s @ — Wiy
(a) Chhdtflsgarh/gﬁm (b) Madhya pl‘ﬂdesh/ﬁﬂ’{@‘a f
L/((«)' Gujarat /IS (d) Assam/ npmy
106, Which of the following sentences is not correct ?
@ Sheis five feat tall. ’
by~ Since 1 joft school, T have been working as typist in thyjg Company, 4
9 Are You hearing a noise? ‘
@ A hammer is yseq for driving in nails: l‘
5\\-M”\~—“~w—-—-m |
P.T,0, !
)
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ale meaning of ‘Reticule’ :
[8

¥ 7p1‘0P1'i ’
107. Choose the mostaF p) atheft Mo alady’s pyrse (d) sleep
(a) aboy’s purse (
a 3
Ov(}l'b.

.y r
108. Choose the correct P

urs
(@) Itever rains but PO

e a quarrel
(b) It takes three to make a que

I go d
d . . . %

. . SiVe Voice .
109.  Change the following into Passi¥
I'found him sleeping.

(@) Sleeping wasfound by him__ (b)  Fam foung sleeping by him

‘——ﬂ'
He was found sleeping by him (?0 He was found sleepmg by me.

110.  To meet one’s waterloo means :
(@) to meet one’s defeat
(b)  to meet Napolean oL
© to get into water
(d) to get one’s victory

111.  Find out the correct spelling :

A& Rheumatic (%Z Rheumetic /@) Rhumetic (}}i) Rhumatic
112. ‘Radijus’ is the singular of ;
(@) Radi (b)  Radee {¢)  Radii _{d)> Raduis

113. Choose the correct word for the blanks,

He uld speak fiye languages.
, Xé{ Challengeq (b) Boasteq (c) Suggested

(d)  Submitteq
114. The antonym of MALIGN js .

(@) slender ’ /"(b) i

() criticize (d)  none of the above

FG/C o
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5 Adiective form of word Silk’ §g
{15,
() Silken

A0) Silkness (9 Silkjess @ Skl
116, Punctuate the followmg :

(b)  Itis mind, aftey
© Itismind

work of the world, “

(d) “Itis ming, aftey all, which does the work of the world”

said my mother”

» said my mother,

117. Choose the noun form of the given word «
"Choose’

@)  Chosen /éb)/ / Choosen

(€©)  Chesen (d)
118. Ch

Choice
ange the following into an Indirect statement -

“Do you hear me?” said Shylock to Antonio,

(@)  Shylock told Antonio that he heard him,

(b)  Shylock asked Antonio if he heard him,

(€)  Shylock askeq Antonio whether he hears him,
(d)  None of the above.

119, Fillin the blank With correct aption,

Thave no contro] my temper,

(b)  over

a) in (© at (d)  after
120, Arrange the given parts of the Sentence in order o produce
P, whena chemical substance

a correct Sentence :
Q. The food poisoning occurred, )
R. inthe food Preparation
S was mistaken for salt and useq
(a) QSRP Ly QPS}{ (©  QPRrs (d) SPOR
)4 2
000~
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